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Chapter 1 Wash, Stain and Scan Protocol Using the 
GeneChip™ Hybridization Wash and Stain Kit 
This chapter is for users of the GeneChip™ Hybridization, Wash and Stain Kit and contains instructions for using the 
Fluidics Station 450/250 to automate the washing and staining of eukaryotic GeneChip™ expression probe arrays and 
instructions for scanning probe arrays using the GeneChip™ Scanner 3000. For specific information pertaining to 
target hybridization, please refer to your target preparation protocol. 

 

 
NOTE: For users preparing their own wash and stain reagents, please refer to Chapter 2, 
Wash, Stain and Scan Protocol with User-Prepared Reagents. 

 

 
CAUTION: Data generated using the GeneChip Hybridization, Wash and Stain Kit and the 
user-prepared solutions are very similar, but not identical. In the course of a project, only 
one method should be used to minimize the experimental variation. 

After completing the procedures described in this chapter, the probe array is ready to be scanned, as described in 
Chapter 3, Probe Array Scan. 

Reagents and Materials Required 
The following reagents and materials have been tested and evaluated by the scientists. Information and part numbers 
listed are based on U.S. catalog information. 

 GeneChip™ Hybridization, Wash and Stain Kit: P/N 900720 (30 reactions)  

Stain Module from Box 1 
- Stain Cocktail 1 
- Stain Cocktail 2 
- Array Holding Buffer 

Wash Buffers A and B from Box 2 
- Wash Buffer A (P/N 900721)1 
- Wash Buffer B (P/N 900722)1 

 RNase-free water 
  

                                                           
1 Components may be ordered separately. 
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Miscellaneous Supplies 
 Fluidics Station 450:  P/N 00-0079 

 GeneChip™ Scanner 3000 7G: P/N 00-00212 

 Sterile, RNase-free microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent) 

 Sterile, RNase-free microcentrifuge vials, amber, 1.5 mL: USA Scientific, P/N 1615-5507 (or equivalent) 

 Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman (or equivalent) 

 Sterile-barrier pipette tips and non-barrier pipette tips 

 Tygon Tubing, 0.04” inner diameter: Cole-Parmer, P/N H-06418-04 

 Tough-Spots™, Label Dots: USA Scientific, P/N 9185-0000 

 Media Bottle, SQ, 1,000 mL: P/N 400119 

 Media Bottle, SQ, 500 mL (set of 3): P/N 400118  

 Bottle Cap, Pre-Drilled (set of 4): P/N 400137 

Experiment and Fluidics Station Setup 
Step 1: Registering Sample Information 
To wash, stain, and scan a probe array, a sample file must first be registered in GeneChip Command Console (GCC). 
Please follow the instructions detailed in the “Creating and Editing Sample Files” section of the GCC User Guide. 

In GCC, the samples are the beginning of the data chain for a given experiment. The sample information is stored in a 
Sample file with an ARR extension. The Sample (ARR) file contains two types of information: 

 Sample Attributes: information that you can use to interpret the experimental data. It can include information 
about the sample itself, the experimental conditions, or other information you may find useful. 
 

 Array Information: information about the array(s) used with the sample. More than one array can be 
associated with the sample. This might be useful for making sure that data from products that contain more 
than one array remain related or to help describe experiments that use replicates. 

Step 2: Preparing the Fluidics Station 
The Fluidics Station 450/250 is used to wash and stain the probe arrays. It is operated using GeneChip Command 
Console. 

Setting Up the Fluidics Station 
1. Turn on the Fluidics Station using the toggle switch on the lower left side of the machine. 

2. In the GCC Launcher, click the GCC Fluidics Control Icon; or Click on the Microsoft Windows Start button 
and select Programs → Affymetrix→ Command Console → GCC Fluidics Control. 

3. The GCC fluidics Control window opens (Figure 1.1). 
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Figure 1.1 GCC Fluidics Control window 

 

The GCC Fluidics Control window has the following components: 

 Menu Bar: Provides access to Fluidics Control functions.  

 Tool Bar: Provides quick access to frequently used functions.  

 Master/Station Controls: Click the tabs to switch between: 
- Master Controls: Use to select a single protocol to run on multiple stations and/or modules. 

 
NOTE: Refer to the appropriate GeneChip™ Fluidics Station User Guide for instructions 
on connecting and addressing multiple fluidics stations. 

- Station Controls: Use to select different protocols to run on different modules in a station. 

 Status Window: Displays list of arrays in process with information on their status.  

 Status Bar: Displays information about the status of the Fluidics station and the fluidics run in progress. 
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Priming the Fluidics Station 
Priming ensures that the lines of the fluidics station are filled with the appropriate buffers and the fluidics station is 
ready for running fluidics station protocols. 

Priming should be done: 

 when the fluidics station is first started.  

 when wash solutions are changed.  

 before washing, if a shutdown has been performed.  

 if the LCD window indicates the instrument is ‘NOT PRIMED’. 

To Prime the Fluidics Station: 
1. Fill the intake buffer reservoirs on the right side of the instrument with the appropriate Wash A and Wash B 

solutions (refer to the appropriate support documentation). 

2. Empty the waste bottle and fill the water reservoir with deionized water. 

3. Place 3 empty 1.5 mL microfuge tubes into the stain holder positions 1, 2 and 3. 

4. Place the washblock lever into the engaged/closed position. Push the needle lever into the down position. 

5. Run the Prime_450 maintenance protocol from the GCC Fluidics Control. For more information on running a 
protocol continue to Probe Array Wash and Stain. 

Probe Array Wash and Stain 
After 16 hours of hybridization remove the array from the hybridization oven. Vent the array by inserting a clean 
pipette tip into one of the septa, and extract the hybridization cocktail with a pipettor through the remaining septum. 
The used hybridization cocktail can be rehybed on another array if necessary. Store the cocktail at -20°C. Refill the 
probe array completely with the appropriate volume of Wash Buffer A, as given in Table 1.1. 

Table 1.1 Probe Array Cartridge Volumes for Wash Buffer A and Array Holding Buffer 

Array Volume 

49 Format (Standard) 250 µL 

64 Format 250 µL 

100 Format (Midi) 160 µL 

169 Format (Mini) 100 µL 

400 Format (Micro) 100 µL 

 

 
NOTE: If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours 
before proceeding with washing and staining. Equilibrate the probe array to room 
temperature before washing and staining. 

The wash and stain procedure takes approximately 90 minutes to complete. 
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Preparing the Stain Reagents 
Prepare the following reagents. Volumes given are sufficient for one probe array. 

1. Remove Stain Cocktail 1, Stain Cocktail 2, and Array Holding Buffer from the Stain Module, Box 1. 

2. Gently tap the bottles to mix well. 

3. Aliquot the following reagents: 
a. 600 µL of Stain Cocktail 1 into a 1.5 mL amber microcentrifuge vial. 
b. 600 µL of Stain Cocktail 2 into a 1.5 mL (clear) microcentrifuge vial. 
c. 800 µL of Array Holding Buffer into a 1.5 mL (clear) microcentrifuge vial. 

4. Spin down all vials to remove the presence of any air bubbles. 
 

 
NOTE: Stain Cocktail 1 is light-sensitive. Please be sure to use amber microcentrifuge 
vials when aliquoting. 

 

 
IMPORTANT: The 600 µL of Stain Cocktail 1 will be used for the first and third stain. 

For instructions on how to use the solutions and determining which Fluidics Script(s) fits your application, please refer 
to Using the Fluidics Station 450/250. One can also access this information at our web site. 

Using the Fluidics Station 450/250 
Washing and Staining the Probe Array 
GCC allows selection of running a protocol on an individual fluidics station and now also enables the user to select the 
same protocol to be run on multiple fluidics stations simultaneously. For running protocols across multiple stations 
simultaneously proceed to Running a Fluidics Protocol on Multiple Stations. 

Running Fluidics on Individual Stations 
You can also select a particular fluidics protocol on an individual station and module. 

To select and run a fluidics protocol on an individual station and module: 

1. Start the GCC Fluidics Control Software. The software opens with the Master controls displayed. 

2. Click the tab for the station you wish to use (Figure 1.2). 

Figure 1.2 Tabs for Master Station and Controls 

 

The Station controls tab displays the module controls for the selected station. Each module control has the same 
functions (Figure 1.3). 



 

10 GeneChipTM Expression Wash, Stain and Scan For Expression Cartridge Arrays User Guide 

Figure 1.3 Module Control 

 

3. Click the Refresh button to refresh the list of Sample files. 

4. Click in the Barcode box and enter the barcode using the keyboard; or scan the barcode with an external 
barcode reader. 

5. Press the Tab key. 

6. The following items are selected automatically if the barcode is valid: 
 Sample File Name: Sample File with which the barcode is associated.  
 Array Name: Array name with which the barcode is associated.  
 Probe Array Type: Probe array type with which the barcode is associated. 
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Figure 1.4 Barcode entered, Sample File name, Array Name, and Probe Array type automatically selected 

 

If you enter a valid barcode or specify the array name by other means, the fluidics protocol information is kept 
with the Audit file for the array. 

You can also: 
 Select a Sample file without entering the barcode. In this case, if the Sample file has more than one array 

associated with it, you will need to select the proper array from the Array Name list. 
 Specify a protocol without specifying a Sample file or array. In this case, the fluidics protocol information 

is kept in an audit file that does not link to a particular Sample file. 

7. Set the options to filter the fluidics protocol selections (Figure 1.5). 

Figure 1.5 Selecting options for protocol selection 
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To limit the protocols listed select one of the following buttons: 
 All (lists all protocols available on your computer)  
 Compatible (displays only protocols that can be used with the selected labeling kit): 

Select the appropriate checkboxes: 
 GeneChip IVT Labeling Kit  
 GeneChip HWS Kit  
 Custom (displays only protocols that have been edited or provided by the user)  
 Maintenance (displays only maintenance protocols) 

Only the protocols that meet the selected requirements are displayed. 

8. Select the fluidics protocol from the Protocol list (Figure 1.6). 

Figure 1.6 Selecting options for protocol selection 

 
 

 
IMPORTANT: The protocol that is displayed in the Protocol drop-down box after entering a 
barcode or selecting a sample name or probe array type may or may not be the correct 
protocol for the array, depending upon the type of analysis being performed. To make 
sure the correct protocol is selected, select the correct options for filtering the protocol 
list as described above. 

 

9. Click Run to start the protocol on the selected module; or 
From the Start menu, select Run All Modules on Current Station; or  
Click the Run All Modules on Current Station button. 

10. Insert the appropriate probe array into the designated module of the fluidics station while the cartridge lever is 
in the down, or eject, position. When finished, verify that the cartridge lever is returned to the up, or engaged, 
position. (If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
please refer to the appropriate Fluidics Station User’s Guide or Quick Reference Card (P/N 08-0093 for the FS-
450/250 fluidics stations). 

11. Remove any microcentrifuge vial remaining in the sample holder of the fluidics station module(s) being used. 
Make sure the wash solutions and water reservoirs contain enough liquid for the run to complete and that the 
waste bottle has enough room to collect waste for the run. 

12. Follow the instructions on the LCD window on the fluidics station by placing the three experiment sample vials 
(the microcentrifuge vials) into the sample holders 1, 2, and 3 on the fluidics station. 
a. Place one vial containing 600 µL Stain Cocktail 1 in sample holder 1. 
b. Place one vial containing 600 µL Stain Cocktail 2 in sample holder 2. 
c. Place one vial containing 800 µL of Array Holding Buffer in sample holder 3. 
d. Press down on the needle lever to snap needles into position and to start the run. 

The run begins. The Fluidics Station dialog box at the workstation terminal and the LCD window display 
the status of the washing and staining as the protocol progresses. 

13. When the protocol is complete, the LCD window displays the message EJECT & INSPECT CARTRIDGE. 
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14. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever to the 
eject position. Do NOT engage the washblock. 

15. Check the probe array window for bubbles or air pockets. 
 If the probe array has no bubbles, it is ready to scan on the GeneChip Scanner 3000. Pull up on the cartridge 

lever to engage washblock and proceed to Chapter 3, Probe Array Scan. 
 If bubbles are present, do the following: 

Return the probe array to the washblock probe array holder. Follow instructions on the LCD window. 
Engage the washblock by gently pushing up on the cartridge lever to the engaged, or closed, position. 

The fluidics station will drain the probe array and then fill it with Array Holding Buffer. When it is finished, 
the LCD window will display EJECT & INSPECT CARTRIDGE. Again, remove the probe array and 
inspect it for bubbles. If no bubbles are present, it is ready to scan. Pull up on the lever to close the washblock 
and proceed to Chapter 3, Probe Array Scan on. 

If attempt to fill the probe array without bubbles is unsuccessful, the array should be filled manually with 
Array Holding Buffer using a micropipette. Excessive washing will result in a loss of signal intensity. 

16. If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for scanning 
for a maximum of 24 hours. 

17. If there are no more samples to hybridize, shut down the fluidics station following the procedure outlined in the 
section, Shutting Down the Fluidics Station. 

 

Running a Fluidics Protocol on Multiple Stations 
You can run a selected protocol on any or all modules in the Fluidics stations attached to the workstation using the 
Master controls. 

To select and run a fluidics protocol for a set of probe arrays: 
1. Start the GCC Fluidics Control Software. The software opens with the Master controls displayed (Figure 1.7). 

Figure 1.7 Master Controls 

 

2. Select the array type from the Probe Array Type list (Figure 1.8). 
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Figure 1.8 Selecting probe array type 

 

 

 
IMPORTANT: The protocol that is displayed in the Protocol drop-down box after selecting 
the probe array type may or may not be the correct protocol for the array, depending upon 
the type of analysis being performed. To make sure the correct protocol is selected, follow 
the steps below. 

 

3. Limit the protocols listed by selecting from the different options (Figure 1.9). 

Figure 1.9 Selecting options to filter the list of protocols 

 

To limit the protocols listed, select one of the following buttons: 
 List All Protocols  
 List Compatible Protocols Only (displays only protocols that can be used with the selected labeling kit): 

Select the appropriate checkboxes: 
- GeneChip IVT Labeling Kit  
- GeneChip HWS Kit  

 List Custom Protocols Only (displays only protocols that have been edited or provided by the user) 
 List Maintenance Protocols Only (displays only maintenance protocols) 

Only the protocols that meet the selected requirements are displayed in the Protocol drop-down list. 

4. Select the protocol from the Protocol drop-down list (Figure 1.10). 
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Figure 1.10 Selecting protocols from the list 

 

5. Select the modules to be run by: 
 Selecting individual checkboxes for each module.  
 Clicking the Station ID checkbox to select all modules for a particular station.  
 Clicking Check/Uncheck all Stations and Modules to select/deselect every station and module. 

Figure 1.11 Selecting Stations and Modules 

 

6. Click Copy to Selected Modules. 

The selected protocol is applied to the selected stations and modules. 

7. Fill the intake buffer reservoirs A and B with the appropriate solutions (Refer to the appropriate GeneChip 
probe array package insert). 

 
TIP: Fluidics protocols vary with the format size of your array. However, filling bottle A 
with 250 to 350 mL of solution and bottle B with 150 mL of solution provides enough 
excess solution to prevent running out in a single Fluidics run. 

8. Empty the waste bottle and fill the water reservoir with deionized water. 

9. Click the Run All button; or 
Select Start →    Run All Modules Selected on Master Page. 

The Status window and the module LCD window display the status of the procedure. 

Insert the appropriate probe array into the designated module of the fluidics station while the cartridge lever is 
in the down, or eject, position. When finished, verify that the cartridge lever is returned to the up, or engaged, 
position. 

10. Remove any microcentrifuge vial remaining in the sample holder of the fluidics station module(s) being used. 

11. Follow the instructions on the LCD window on the fluidics station by placing the three experiment sample vials 
(the microcentrifuge vials) into the sample holders 1, 2, and 3 on the fluidics station. 
a. Place one vial containing 600 µL Stain Cocktail 1 in sample holder 1. 
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b. Place one vial containing 600 µL Stain Cocktail 2 in sample holder 2. 
c. Place one vial containing 800 µL of Array Holding Buffer in sample holder 3.  
d. Press down on the needle lever to snap needles into position and to start the run. The run begins. The 

Fluidics Station dialog box at the workstation terminal and the LCD window display the status of the 
washing and staining as the protocol progresses. 

12. When the protocol is complete, the LCD window displays the message EJECT & INSPECT CARTRIDGE. 

13. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever to the 
eject position. 

14. Check the probe array window for large bubbles or air pockets. 
 If the probe array has no large bubbles, it is ready to scan on the GeneChip™ Scanner 3000. Pull up on the 

cartridge lever to engage washblock and proceed to Chapter 3, Probe Array Scan. 
 If bubbles are present, do the following: 

Return the probe array to the probe array holder. Follow instructions on the LCD window. Engage the 
washblock by gently pushing up on the cartridge lever to the engaged, or closed, position. 

The fluidics station will drain the probe array and then fill it with Array Holding Buffer. When it is finished, 
the LCD window will display EJECT & INSPECT CARTRIDGE. Again, remove the probe array and 
inspect it for bubbles. If no bubbles are present, it is ready to scan. Pull up on the lever to close the washblock 
and proceed to Chapter 3, Probe Array Scan.  

If attempt to fill the probe array without bubbles is unsuccessful, the array should be filled manually with 
Array Holding Buffer using a micropipette. Excessive washing will result in a loss of signal intensity. 

15. If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for scanning 
for a maximum of 24 hours. 

16. If there are no more samples to hybridize, shut down the fluidics station following the procedure outlined in the 
section, Shutting Down the Fluidics Station. 

Shutting Down the Fluidics Station 
You should perform the Shutdown protocol at the end of a session. Do not keep the fluidics station on and primed if 
you will not use it again within the next 12 hours. This will reduce the risk of salt buildup in the instrument. 

1. Place the Wash A and Wash B lines into deionized water. 

2. Place empty 1.5 mL microfuge tubes in the stain holders on the front of the instrument. 

3. Run the Shutdown_450 Protocol following the above section for running either an individual station or 
multiple fluidics stations  

4. Once this Shutdown is complete the LCD display will indicate the station is no longer primed. Turn off the 
Fluidics Station using the toggle switch on the lower left side of the machine. 

 
NOTE: For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to Appendix A, Fluidics Station Care and Maintenance. 

Customizing a Protocol 
For instructions on creating a custom protocol, please refer to the “Editing a Protocol” section of Chapter 5 in the 
GeneChip™ Command Console™ User Guide (Pub. No. 702569). 
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Chapter 2 Wash, Stain and Scan Protocol with User-
Prepared Reagents 
This chapter is for users preparing their own wash and stain reagents and contains instructions for using the Fluidics 
Station 450/250 to automate the washing and staining of eukaryotic GeneChip™ expression probe arrays and 
instructions for scanning probe arrays using the GeneChip™ Scanner 3000. For specific information pertaining to 
target hybridization, please refer to your target preparation protocol. 

 
NOTE: For customers using the GeneChip™ Hybridization, Wash and Stain Kit, please 
refer to Chapter 1, Wash, Stain and Scan Protocol Using the GeneChip™ Hybridization 
Wash and Stain Kit. 

 

 
CAUTION: Data generated using the GeneChip Hybridization, Wash and Stain Kit and 
the user-prepared solutions are very similar, but not identical. In the course of a 
project, only one method should be used to minimize the experimental variation. 

We offer a complete set of GeneChip reagents developed specifically for use with GeneChip™ 3’ eukaryotic arrays in 
cartridge format. GeneChip™ reagent kits include the IVT Express and Hybridization, Wash, and Stain Kits. For best 
results, it is highly recommended that all GeneChip reagents are used for target preparation, hybridization, wash, and 
staining when using GeneChip arrays. 

The information and protocols described in this section have been provided in the GeneChip™ Expression Analysis 
Technical Manual describing hybridization, wash, and staining procedures for GeneChip 3’ eukaryotic arrays in 
cartridge format. These protocols should be closely followed when the GeneChip™ Hybridization, Wash, and Stain 
Kit is not used. 

After completing the procedures described in this chapter the probe array is ready to be scanned, as described in 
Chapter 3, Probe Array Scan. 

Reagents and Materials Required 
The following reagents and materials have been tested and evaluated by the scientists. Information and part numbers 
listed are based on U.S. catalog information. 

 Water, Molecular Biology Grade: Cambrex, P/N 51200  

 Distilled water: P/N 15230-147  

 Bovine Serum Albumin (BSA) solution (50 mg/mL): P/N 15561-020  

 R-Phycoerythrin Streptavidin: P/N S-866  

 5 M NaCl, RNase-free, DNase-free: P/N 9760G  

 20X SSPE (3 M NaCl, 0.2M NaH2PO4, 0.02 M EDTA): Cambrex, P/N 51214  

 Goat IgG, Reagent Grade: Sigma-Aldrich, P/N I 5256  

 Anti-streptavidin antibody (goat), biotinylated: Vector Laboratories, P/N BA-0500  

 Surfact-Amps 20 (Tween-20), 10%: Pierce Chemical, P/N 28320  

 MES hydrate SigmaUltra: Sigma-Aldrich, P/N M5287  

 MES Sodium Salt: Sigma-Aldrich, P/N M5057 
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Miscellaneous Supplies 

 Fluidics Station 450: P/N 00-0079  

 GeneChip™ Scanner 3000 7G: P/N 00-00212  

 Sterile, RNase-free microcentrifuge vials, 1.5 mL: USA Scientific, P/N 1415-2600 (or equivalent)  

 Sterile, RNase-free microcentrifuge vials, amber, 1.5 mL: USA Scientific, 

 P/N 1615-5507 (or equivalent) 

 Micropipettors, (P-2, P-20, P-200, P-1000): Rainin Pipetman (or equivalent)  

 Sterile-barrier pipette tips and non-barrier pipette tips  

 Tygon Tubing, 0.04" inner diameter: Cole-Parmer, P/N H-06418-04  

 Tough-Spots™, Label Dots: USA Scientific, P/N 9185-0000  

 Media Bottle, SQ, 1,000 mL: P/N 400119  

 Media Bottle, SQ, 500 mL (set of 3): P/N 400118  

 Bottle Cap, Pre-Drilled (set of 4): P/N 400137 

Reagent Preparation 
12X MES Stock Buffer 
(1.22 M MES, 0.89M [Na+]) 

For 1,000 mL: 

64.61 g of MES hydrate 

193.3 g of MES Sodium Salt 

800 mL of Molecular Biology Grade water 

Mix and adjust volume to 1,000 mL. 

The pH should be between 6.5 and 6.7. Filter through a 0.2 µm filter. 

 
IMPORTANT: Do not autoclave. Store at 2°C to 8°C, and shield from light. Discard solution 
if yellow. 

Wash Buffer A: Non-Stringent Wash Buffer 
(6X SSPE, 0.01% Tween-20) 

For 1,000 mL: 

300 mL of 20X SSPE 

1.0 mL of 10% Tween-20 

699 mL of water 

Filter through a 0.2 µm filter 
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Wash Buffer B: Stringent Wash Buffer 
(100 mM MES, 0.1M [Na+], 0.01% Tween-20) 

For 1,000 mL: 

83.3 mL of 12X MES Stock Buffer 

5.2 mL of 5 M NaCl 

1.0 mL of 10% Tween-20 

910.5 mL of water 

Filter through a 0.2 µm filter 

Store at 2°C to 8°C and shield from light 

2X Stain Buffer 
(Final 1X concentration: 100 mM MES, 1 M [Na+], 0.05% Tween-20) 

For 250 mL: 

41.7 mL of 12X MES Stock Buffer 

92.5 mL of 5 M NaCl 

2.5 mL of 10% Tween-20 

113.3 mL of water 

Filter through a 0.2 µm filter 

Store at 2°C to 8°C and shield from light 

10 mg/mL Goat IgG Stock 
Resuspend 50 mg in 5 mL of 150 mM NaCl  

Store at 4°C 

 

 
NOTE: If a larger volume of the 10 mg/mL IgG stock is prepared, aliquot and store at –
20°C until use. After the solution has been thawed it should be stored at 4°C. Avoid 
additional freezing and thawing. 

 

1X Array Holding Buffer 

(100 mM MES, 1M [Na+], 0.01% Tween-20) 

For 100 mL: 

8.3 mL of 12X MES Stock Buffer 

18.5 mL of 5M NaCl 

0.1 mL of 10% Tween-20 

73.1 mL of Molecular Biology Grade water 

Store at 2°C to 8°C and shield from light. 
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Experiment and Fluidics Station Setup 
Step 1: Registering Sample Information 
To wash, stain, and scan a probe array, a sample file must first be registered in GeneChip Command Console (GCC). 
Please follow the instructions detailed in the “Creating and Editing Sample Files” section of the GCC User Guide. 

In GCC, the samples are the beginning of the data chain for a given experiment. The sample information is stored in a 
Sample file with an ARR extension. The Sample (ARR) file contains two types of information: 

 Sample Attributes: information that you can use to interpret the experimental data. It can include information 
about the sample itself, the experimental conditions, or other information you may find useful.  

 Array Information: information about the array(s) used with the sample. More than one array can be 
associated with the sample. This might be useful for making sure that data from products that contain more 
than one array remain related or to help describe experiments that use replicates. 

Step 2: Preparing the Fluidics Station 
The Fluidics Station 450/250 is used to wash and stain the probe arrays. It is operated using GeneChip Command 
Console. 

Setting Up the Fluidics Station 
1. Turn on the Fluidics Station using the toggle switch on the lower left side of the machine. 

2. In the GCC Launcher, click the GCC Fluidics Control Icon; or Click on the Microsoft Windows Start button 
and select Programs → Affymetrix → Command Console → GCC Fluidics Control. 

3. The GCC fluidics Control window opens (Figure 2.1). 

Figure 2.1 GCC Fluidics Control window 

 

The GCC Fluidics Control window has the following components: 

 Menu Bar: Provides access to Fluidics Control functions.  

 Tool Bar: Provides quick access to frequently used functions.  



 

 

GeneChipTM Expression Wash, Stain and Scan For Expression Cartridge Arrays User Guide  
 21 

 Master/Station Controls: Click the tabs to switch between: 
- Master Controls: Use to select a single protocol to run on multiple stations and/or modules. 

 
NOTE: Refer to the appropriate GeneChip™ Fluidics Station User’s Guide for instructions 
on connecting and addressing multiple fluidics stations. 

- Station Controls: Use to select different protocols to run on different modules in a station.  

 Status Window: Displays list of arrays in process with information on their status.  

 Status Bar: Displays information about the status of the Fluidics station and the fluidics run in progress. 

Priming the Fluidics Station 
Priming ensures that the lines of the fluidics station are filled with the appropriate buffers and the fluidics station is 
ready for running fluidics station protocols. 

Priming should be done: 

 when the fluidics station is first started.  

 when wash solutions are changed.  

 before washing, if a shutdown has been performed.  

 if the LCD window indicates the instrument is ‘NOT PRIMED’. 

To Prime the Fluidics Station: 

1. Fill the intake buffer reservoirs on the right side of the instrument with the appropriate Wash A and Wash B 
solutions (refer to the appropriate support documentation). 

2. Empty the waste bottle and fill the water reservoir with deionized water. 

3. Place 3 empty 1.5 mL microfuge tubes into the stain holder positions 1, 2 and 3. 

4. Place the washblock lever into the engaged/closed position. Push the needle lever into the down position. 

5. Run the Prime_450 maintenance protocol from the GCC Fluidics Control. For more information on running a 
protocol continue to Probe Array Wash and Stain. 

Probe Array Wash and Stain 
After 16 hours of hybridization remove the array from the hybridization oven. Vent the array by inserting a clean 
pipette tip into one of the septa, and extract the hybridization cocktail with a pipettor through the remaining septum. 
The used hybridization cocktail can be rehybed on another array if necessary. Store the cocktail at -20°C. Refill the 
probe array completely with the appropriate volume of Wash Buffer A, as given in Table 2.1. 
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Table 2.1 Probe Array Cartridge Volumes for Wash Buffer A and Array Holding Buffer 
Array Volume 

49 Format (Standard) 250 µL 

64 Format 250 µL 

100 Format (Midi) 160 µL 

169 Format (Mini) 100 µL 

400 Format (Micro) 100 µL 

 

 
NOTE: If necessary, at this point, the probe array can be stored at 4°C for up to 3 hours 
before proceeding with washing and staining. Equilibrate the probe array to room 
temperature before washing and staining. 

The wash and stain procedure takes approximately 90 minutes to complete. 

Preparing the Staining Reagents 
Prepare the following reagents. Volumes given are sufficient for one probe array. 

SAPE Stain Solution 
Streptavidin Phycoerythrin (SAPE) should be stored in the dark at 4°C, either foil-wrapped or kept in an amber tube. 
Remove SAPE from the refrigerator and tap the tube to mix well before preparing stain solution. Do not freeze SAPE. 
Always prepare the SAPE stain solution fresh, on the day of use. 

Table 2.2 SAPE Solution Mix 
Component Volume Final Dilution 

2X Stain Buffer 600.0 µL 1X 

50 mg/mL BSA 48.0 µL 2 mg/mL 

1 mg/mL Streptavidin Phycoerythrin (SAPE) 12.0 µL 10 µg/mL 

DI H20 540.0 µL — 

Total Volume 1200 µL  

Mix well and divide into two aliquots of 600 µL each to be used for stains 1 and 3. 
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Antibody Solution 
Table 2.3 Antibody Solution Mix 
Component Volume Final Dilution 

2X Stain Buffer 300.0 µL 1X 

50 mg/mL BSA 24.0 µL 2 mg/mL 

10 mg/mL Goat IgG Stock 6.0 µL 0.1 mg/mL 

0.5 mg/mL biotinylated antibody 3.6 µL 3 µg/mL 

DI H20 266.4 µL — 

Total Volume 600 µL  

 
Table 2.4 Fluidics Scripts for 11 µm and ≥18 µm Feature Size Eukaryotic Arrays 

Array Format 11 µm Feature Size using 
GeneChip™ 3’ IVT Express Kit 
or GeneChip™ 3’ IVT labeling 

Kit 

11 µm Feature Size Using All 
Other Labeling Kits 

> 18 µm Feature Size 
All Labeling Kits 

49 format EukGE-WS2v5_450 EukGE-WS2v4_450 EukGE-WS2v4_450 

64 format EukGE-WS2v5_450 EukGE-WS2v4_450 EukGE-WS2v4_450 

100 format Midi_euk2v3_450 Midi_euk2v3_450 Midi_euk2v3_450 

169 format Mini_euk2v3_450 Mini_euk2v3_450 Mini_euk2v3_450 

400 format Micro_1v1_450 Micro_1v1_450 Micro_1v1_450 

 
Table 2.5 Fluidics Protocols - Antibody Amplification for Eukaryotic Targets 

EukGE-WS2v4_450 EukGE-WS2v5_450 
Midi_euk2_450 

Micro_1_450  
Mini_euk2_450 

Post Hyb Wash #1 10 cycles of 2 mixes/ 
cycle with Wash Buffer A  
at 25°C 

10 cycles of 2 mixes/ 
cycle with Wash Buffer A  
at 30°C 

10 cycles of 2 mixes/cycle with 
Wash Buffer A at 25°C 

Post Hyb Wash #2 4 cycles of 15 mixes/ 
cycle with Wash Buffer B  
at 50°C 

6 cycles of 15 mixes/ 
cycle with Wash Buffer B  
at 50°C 

8 cycles of 15 mixes/cycle with 
Wash Buffer B at 50°C 

1st Stain Stain the probe array for  
10 minutes in SAPE solution 
at 25°C 

Stain the probe array for  
5 minutes in SAPE solution at 
35°C 

Stain the probe array for 10 
minutes in SAPE solution at 
25°C 

Post Stain Wash 10 cycles of 4 mixes/ 
cycle with Wash Buffer A  
at 25°C 

10 cycles of 4 mixes/ 
cycle with Wash Buffer A  
at 30°C 

10 cycles of 4 mixes/cycle with 
Wash Buffer A at 30°C 

2nd Stain Stain the probe array for  
10 minutes in antibody 
solution at 25°C 

Stain the probe array for  
5 minutes in antibody solution 
at 35°C 

Stain the probe array for 10 
minutes in antibody solution at 
25°C 
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EukGE-WS2v4_450 EukGE-WS2v5_450 
Midi_euk2_450 

Micro_1_450  
Mini_euk2_450 

3rd Stain Stain the probe array for  
10 minutes in SAPE solution 
at 25°C 

Stain the probe array for  
5 minutes in SAPE solution at 
35°C 

Stain the probe array for 10 
minutes in SAPE solution at 
25°C 

Final Wash 15 cycles of 4 mixes/cycle 
with Wash Buffer A at 30°C. 
The holding temperature is 
25°C 

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C. The 
holding temperature is 25°C 

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C. The 
holding temperature is 25°C 

Final Wash 15 cycles of 4 mixes/cycle 
with Wash Buffer A at 30°C. 
The holding temperature is 
25°C 

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C. The 
holding temperature is 25°C 

15 cycles of 4 mixes/cycle with 
Wash Buffer A at 35°C. The 
holding temperature is 25°C 

  Wash Buffer A = non-stringent wash buffer 
  Wash Buffer B = stringent wash buffer 

Using the Fluidics Station 450/250 
Washing and Staining the Probe Array 
GCC allows selection of running a protocol on an individual fluidics station and now also enables the user to select the 
same protocol to be run on multiple fluidics stations simultaneously. For running protocols across multiple stations 
simultaneously proceed to Running a Fluidics Protocol on Multiple Stations. 

Running Fluidics on Individual Stations 
You can also select a particular fluidics protocol on an individual station and module. 

To select and run a fluidics protocol on an individual station and module: 
1. Start the GCC Fluidics Control Software. The software opens with the Master controls displayed. 

2. Click the tab for the station you wish to use (Figure 2.2). 

Figure 2.2 Tabs for Master Station and Controls 

 

The Station controls tab displays the module controls for the selected station. Each module control has the same 
functions (Figure 2.3). 
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Figure 2.3 Module Control 

 

3. Click the Refresh button to refresh the list of Sample files. 

4. Click in the Barcode box and enter the barcode using the keyboard; or scan the barcode with an external 
barcode reader. 

5. Press the Tab key. 

6. The following items are selected automatically if the barcode is valid: 
 Sample File Name: Sample File with which the barcode is associated.  
 Array Name: Array name with which the barcode is associated.  
 Probe Array Type: Probe array type with which the barcode is associated. 
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Figure 2.4 Barcode entered, Sample File name, Array Name, and Probe Array type automatically selected 

 

If you enter a valid barcode or specify the array name by other means, the fluidics protocol information is kept 
with the Audit file for the array. 

You can also: 
 Select a Sample file without entering the barcode. In this case, if the Sample file has more than one array 

associated with it, you will need to select the proper array from the Array Name list. 
 Specify a protocol without specifying a Sample file or array. In this case, the fluidics protocol information 

is kept in an audit file that does not link to a particular Sample file. 

7. Set the options to filter the fluidics protocol selections (Figure 2.5). 

Figure 2.5 Selecting options for protocol selection 

 

To limit the protocols listed select one of the following buttons: 
 All (lists all protocols available on your computer)  
 Compatible (displays only protocols that can be used with the selected labeling kit): 

Select the appropriate checkboxes: 
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 GeneChip IVT Labeling Kit  
 GeneChip HWS Kit  
 Custom (displays only protocols that have been edited or provided by the user)  
 Maintenance (displays only maintenance protocols) 

Only the protocols that meet the selected requirements are displayed. 

8. Select the fluidics protocol from the Protocol list (Figure 2.6). 

Figure 2.6 Selecting the protocol 

 

 

 
IMPORTANT: The protocol that is displayed in the Protocol drop-down box after entering a 
barcode or selecting a sample name or probe array type may or may not be the correct 
protocol for the array, depending upon the type of analysis being performed. To make 
sure the correct protocol is selected, select the correct options for filtering the protocol 
list as described above. 

9. Click Run to start the protocol on the selected module; or 
From the Start menu, select Run All Modules on Current Station; or 
Click the Run All Modules on Current Station button. 

10. Insert the appropriate probe array into the designated module of the fluidics station while the cartridge lever is 
in the down, or eject, position. When finished, verify that the cartridge lever is returned to the up, or engaged, 
position. (If you are unfamiliar with inserting and removing probe arrays from the fluidics station modules, 
please refer to the appropriate Fluidics Station User’s Guide or Quick Reference Card (Pub. No. 08-0093 for 
the FS-450/250 fluidics stations). 

11. Remove any microcentrifuge vial remaining in the sample holder of the fluidics station module(s) being used. 
Make sure the wash solutions and water reservoirs contain enough liquid for the run to complete and that the 
waste bottle has enough room to collect waste for the run. 

12. Follow the instructions on the LCD window on the fluidics station by placing the three experiment sample vials 
(the microcentrifuge vials) into the sample holders 1, 2, and 3 on the fluidics station. 
a. Place one vial containing 600 µL SAPE Stain Solution in sample holder 1. 
b. Place one vial containing 600 µL Antibody Solution in sample holder 2. 
c. Place one vial containing 600 µL of SAPE Stain Solution in sample holder 3. 
d. Press down on the needle lever to snap needles into position and to start the run. 

The run begins. The Fluidics Station dialog box at the workstation terminal and the LCD window display 
the status of the washing and staining as the protocol progresses. 

13. When the protocol is complete, the LCD window displays the message EJECT & INSPECT CARTRIDGE. 

14. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever to the 
eject position. Do NOT engage the washblock. 

15. Check the probe array window for bubbles or air pockets. 
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 If the probe array has no bubbles, it is ready to scan on the GeneChip Scanner 3000. Pull up on the  
cartridge lever to engage washblock and proceed to Chapter 3, Probe Array Scan. 

 If bubbles are present, do the following: 
Return the probe array to the washblock probe array holder. Follow instructions on the LCD window. 
Engage the washblock by gently pushing up on the cartridge lever to the engaged, or closed, position. 

The fluidics station will drain the probe array and then fill it with Wash A Buffer. When it is finished, the LCD 
window will display EJECT & INSPECT CARTRIDGE. Remove the probe array from the instrument, 
remove the Wash A Buffer from the array using a micropipette, and refill completely with Array Holding 
Buffer. After confirming that no bubbles are present, the array is ready to scan. 

Proceed to Chapter 3, Probe Array Scan. Pull up on the lever to close the washblock and complete the washing 
procedure. 

16. If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for scanning 
for a maximum of 24 hours. 

17. If there are no more samples to hybridize, shut down the fluidics station following the procedure outlined in the 
section, Shutting Down the Fluidics Station. 

Running a Fluidics Protocol on Multiple Stations 
You can run a selected protocol on any or all modules in the Fluidics stations attached to the workstation using the 
Master controls. 

To select and run a fluidics protocol for a set of probe arrays: 

1. Start the GCC Fluidics Control Software. The software opens with the Master controls displayed (Figure 2.7). 

Figure 2.7 Master Controls 

 

2. Select the array type from the Probe Array Type list (Figure 2.8). 

Figure 2.8 Selecting probe array type 
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IMPORTANT: The protocol that is displayed in the Protocol drop-down box after selecting 
the probe array type may or may not be the correct protocol for the array, depending upon 
the type of analysis being performed. To make sure the correct protocol is selected, follow 
the steps below. 

3. Limit the protocols listed by selecting from the different options (Figure 2.9). 

Figure 2.9 Selecting options to filter the list of protocols 

 

To limit the protocols listed, select one of the following buttons: 
 List All Protocols  
 List Compatible Protocols Only (displays only protocols that can be used with the selected labeling kit): 

 
Select the appropriate checkboxes: 
- GeneChip IVT Labeling Kit  
- GeneChip HWS Kit  

 List Custom Protocols Only (displays only protocols that have been edited or provided by the user) 
 List Maintenance Protocols Only (displays only maintenance protocols) 

Only the protocols that meet the selected requirements are displayed in the Protocol drop-down list. 

4. Select the protocol from the Protocol drop-down list (Figure 2.10). 

Figure 2.10 Selecting protocols from the list 

 

5. Select the modules to be run by: 
 Selecting individual checkboxes for each module.  
 Clicking the Station ID checkbox to select all modules for a particular station.  
 Clicking Check/Uncheck all Stations and Modules to select/deselect every station and module. 
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Figure 2.11 Selecting Stations and Modules 

 

6. Click Copy to Selected Modules. 
 The selected protocol is applied to the selected stations and modules. 

7. Fill the intake buffer reservoirs A and B with the appropriate solutions (Refer to the appropriate GeneChip 
probe array package insert). 

 

 
TIP: Fluidics protocols vary with the format size of your array. However, filling bottle A 
with 250 to 350 mL of solution and bottle B with 150 mL of solution provides enough 
excess solution to prevent running out in a single Fluidics run. 

8. Empty the waste bottle and fill the water reservoir with deionized water. 

9. Click the Run All button; or 
Select Start → Run All Modules Selected on Master Page. 
The Status window and the module LCD window display the status of the procedure. 
Insert the appropriate probe array into the designated module of the fluidics station while the cartridge lever is 
in the down, or eject, position. When finished, verify that the cartridge lever is returned to the up, or engaged, 
position. 

10. Remove any microcentrifuge vial remaining in the sample holder of the fluidics station module(s) being used. 

11. Follow the instructions on the LCD window on the fluidics station by placing the three experiment sample vials 
(the microcentrifuge vials) into the sample holders 1, 2, and 3 on the fluidics station. 
a. Place one vial containing 600 µL SAPE Stain Solution in sample holder 1. 
b. Place one vial containing 600 µL Antibody Solution in sample holder 2. 
c. Place one vial containing 600 µL of SAPE Stain Solution in sample holder 3. 
d. Press down on the needle lever to snap needles into position and to start the run. 

The run begins. The Fluidics Station dialog box at the workstation terminal and the LCD window display 
the status of the washing and staining as the protocol progresses. 

12. When the protocol is complete, the LCD window displays the message EJECT & INSPECT CARTRIDGE. 

13. Remove the probe arrays from the fluidics station modules by first pressing down the cartridge lever to the 
eject position. 

14. Check the probe array window for large bubbles or air pockets. 
 If the probe array has no large bubbles, it is ready to scan on the GeneChip™ Scanner 3000. Pull up on the 

cartridge lever to engage washblock and proceed to Chapter 3, Probe Array Scan. 
 If bubbles are present, do the following: 

Return the probe array to the probe array holder. Follow instructions on the LCD window. Engage the 
washblock by gently pushing up on the cartridge lever to the engaged, or closed, position. 
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The fluidics station will drain the probe array and then fill it with Wash A Buffer. When it is finished, the LCD 
window will display EJECT & INSPECT CARTRIDGE. Remove the probe array from the instrument, 
remove the Wash A Buffer from the array using a micropipette, and refill completely with Array Holding 
Buffer. After confirming that no bubbles are present, the array is ready to scan. Proceed to Chapter 3, Probe 
Array Scan. Pull up on the lever to close the washblock and complete the washing procedure. 

15. If you do not scan the arrays right away, keep the probe arrays at 4°C and in the dark until ready for scanning 
for a maximum of 24 hours. 

16. If there are no more samples to hybridize, shut down the fluidics station following the procedure outlined in the 
section, Shutting Down the Fluidics Station. 

Shutting Down the Fluidics Station 
You should perform the Shutdown protocol at the end of a session. Do not keep the fluidics station on and primed if 
you will not use it again within the next 12 hours. This will reduce the risk of salt buildup in the instrument. 

1. Place the Wash A and Wash B lines into deionized water. 

2. Place empty 1.5 mL microfuge tubes in the stain holders on the front of the instrument. 

3. Run the Shutdown_450 Protocol following the above section for running either an individual station or 
multiple fluidics stations 

4. Once this Shutdown is complete the LCD display will indicate the station is no longer primed. Turn off the 
Fluidics Station using the toggle switch on the lower left side of the machine. 

 
NOTE: For proper cleaning and maintenance of the fluidics station, including the bleach 
protocol, refer to Appendix A, Fluidics Station Care and Maintenance 

Customizing a Protocol 
For instructions on creating a custom protocol, please refer to the “Editing a Protocol” section of Chapter 5 in the 
GeneChip™ Command Console™ User Guide (Pub. No. 702569). 
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Chapter 3 Probe Array Scan 
The scanner is also controlled by GeneChip Command Console (GCC). The probe array is scanned after the wash 
protocols are complete. Make sure the laser is warmed up by turning it on at least 10 minutes prior to scanning if you 
are using the GeneChip™ Scanner 3000. If probe array was stored at 4°C, warm to room temperature before scanning. 
Refer to the GCC online help and the appropriate scanner user’s guide for more information on scanning. 

 
WARNING: The scanner uses a laser and is equipped with a safety interlock system. 
Defeating the interlock system may result in exposure to hazardous laser light. 

 

 
NOTE: You must have read and be familiar with the operation of the scanner before 
attempting to scan a probe array. Please refer to the GeneChip™ Command Console User 
Guide (Pub. No. 702569), or to the GeneChip™ Scanner 3000 Quick Reference Card (Pub. 
No. 08- 0075). 

After completing the procedures described in this chapter, the scanned probe array image (.dat file) is ready for 
analysis, as explained in the GeneChip Expression Analysis: Data Analysis Fundamentals booklet (Pub. No. 701190), 
which may be downloaded from our web site. 

Starting the Scanner 
To turn on the Scanner: 

 Press the on/off (I/O) switch on the front panel. 
The scanner’s onboard computer boots up. The boot-up process takes a few minutes. During this time both the 
yellow and green lights will be on. The scanner enters the laser warm-up state. During this warm-up time, the 
green light will turn off and the yellow light will remain on. You must wait 10 minutes for the laser to stabilize. 
The green light will be solid indicating the scanner is ready to scan an array. 

Handling the GeneChip™ Probe Array 
Before you scan the probe array, follow the directions in this section on handling the probe array. If necessary, clean 
the glass surface of the probe array with a non-abrasive towel or tissue before scanning. Do not use alcohol to clean 
glass. 

Before scanning the probe array cartridge, apply Tough-Spots™ to each of the two septa on the probe array cartridge 
to prevent the leaking of fluids from the cartridge during scanning. 

 
IMPORTANT: Apply the spots just before scanning. 

1. On the back of the probe array cartridge, clean excess fluid from around septa. 

2. Carefully apply one Tough-Spots to each of the two septa. Press to ensure that the spots remain flat. 
If the Tough-Spots do not apply smoothly, that is, if you observe bumps, bubbles, tears, or curled edges, do not 
attempt to smooth out the spot. Remove the spot and apply a new spot. See Figure 3.1. 
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Figure 3.1 Applying Tough-Spots™ to the Cartridge Array 

 

3. Insert the cartridge into the scanner or autoloader. If you observe a focus error message, remove the spot and 
apply a new spot. Ensure that the spots lie flat. 

Scanning the Probe Array 
Starting the Software 
To Start the GCC Scan Control Software: 

 Click the GCC Scan Control icon in the Launcher; or Click the Microsoft™ Windows™ Start button and select 
Programs → Affymetrix → Command Console → GCC Scan Control.  
The GCC Scan Control window opens (Figure 3.2). 
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Figure 3.2 GCC Scan Control window 

 

The GCC Scan Control window has the following components: 
 Menu Bar: Access to functions of the software. 
 Tool Bar: Quick access to commonly used functions. 
 Status Window: Displays list of scanned arrays with information on their status. 
 Status Bar: Displays information about the status of the AutoLoader and the scan in progress. 

To hide or display the toolbar: 

 From the View menu, select Toolbar →Standard Toolbar. 

To add text labels to the toolbar buttons: 

 From the View menu, select Toolbar →Text Labels. 

To hide or display the Status Bar: 

 From the View menu, select Status Bar. 

Scanning a Probe Array in Manual Mode 

If an autoloader is present, one can scan in manual mode by selecting Edit → Options. Select the Enable Manual 
Mode checkbox. To return to autoloader mode, clear the box. 

 Click the Start button in the main tool bar; or 
Select Scanner → Start Scanner from the menu bar. 
The Scanner dialog box opens. 
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Figure 3.3 The Start Scanner dialog box 

 

At this point, you can choose from a number of options: 

 If your array has a valid barcode, you can scan the barcode on the probe array into the barcode field. The 
software will retrieve the sample file and array name associated with the barcode. If the barcode is not 
associated with an existing Sample file and array, a sample file will be created during scan using Drop and 
Scan. For Drop and Scan details, see the GeneChip™ Command Console™ User Guide.  

 If your array does not have a valid barcode, you can manually select an array as described below: 

1. Select the Sample file name for the probe array you wish to scan from the Sample File Name drop-down list. 

2. Select the array name of the probe array to be scanned from the Array Name drop-down list. 
The Probe Array Type field automatically displays the probe array type that was entered while creating the 
Sample file. 

If you want to skip the warm-up period before scanning the first probe array, keep the default check in the 
Arrays at room temperature box. 

3. Click Start in the Start Scanner dialog box to start the run. 

The GeneChip Scanner dialog box appears (Figure 3.4). 

Figure 3.4 Scanner dialog box 

 

The scanner door opens and the chip transport mechanism raises to accept a probe array. 

Load the probe array (Figure 3.5 and Figure 3.6) into the scanner chip transport mechanism. Insert the probe 
array into the chip transport mechanism such that the front of the probe array (label side) faces to the rear of the 
scanner. 
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NOTE: The scanner will enter Park mode if it is unattended for 15 minutes and will enter 
standby, or sleep, mode if it is unattended for 60 minutes (45 minutes after entering Park 
mode). The green light will turn off and the yellow light will turn on. To reactivate the 
laser, click Turn Laser On in the scanner dialog box and wait 10 minutes. Use appropriate 
settings based on the probe array type specified during experiment setup. 

Figure 3.5 GeneChip™ cartridge arrays: note the location of the flange. The scanner will accept the probe array in 
only one orientation. 

 

 

 
CAUTION: Do not force the probe array. If the array does not drop easily into the chip 
transport mechanism, eject the array and try again. If this does not remedy the situation, 
see Troubleshooting and Assistance or call Technical support. 

 

 
CAUTION: If a probe array becomes lodged in the scanner, you can manually remove it. 
For more information, see the GeneChip™ Command Console™ User Guide. 

 
NOTE: You cannot modify the scanner settings. GCC automatically selects the 
appropriate settings based on the probe array type specified during experiment setup. 

 

4. Click OK in the GeneChip Scanner dialog box to start scanning the probe array. 
During the scan, the green light will flash, and the yellow light will be off. 
After the scan starts, the software will start with the autofocus routine. Data collection starts after successful 
completion of autofocus. During the pre-scan state, when autofocus is complete, but before data collection has 
started, the software will count downwards. 

5. After the scan is completed, GCC: 
 Saves the image data.  
 Aligns a grid on the image to identify the probe cells.  
 Computes the probe cell intensity data.  
 Ejects the probe array. 

Once the probe intensity data (.cel file) has been generated, probe summarization can be performed in 
Expression Console, or other applicable downstream software. 
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Figure 3.6 Loading the probe array into the chip transport mechanism. Note that the front of the probe array faces to 
the rear of the scanner. 

 

 

 
NOTE: When multiple emission filters are used during the scan process, the software will 
display the scan with a letter followed by the percentage of scan completed. The letter 
identifies the scan associated with the emission filter. 

For scanning instructions using the autoloader, please refer to Scanning a Probe Array Using the Autoloader. 
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Scanning a Probe Array Using the AutoLoader 
Starting the Software 
To Start the GCC Scan Control Software: 

1. Click the GCC Scan Control icon in the Launcher, or click the Microsoft™ Windows™ Start button and select 
Programs → Affymetrix → Command Console → GCC Scan Control. The GCC Scan Control window 
opens (Figure 3.7). 

Figure 3.7 GCC Scan Control window 

 

The GCC Scan Control window has the following components: 
 Menu Bar: Access to functions of the software.  
 Tool Bar: Quick access to commonly used functions.  
 Status Window: Displays list of scanned arrays with information on their status.  
 Status Bar: Displays information about the status of the AutoLoader and the scan in progress. 

To hide or display the toolbar: 

 From the View menu, select Toolbar → Standard Toolbar. 

To add text labels to the toolbar buttons: 

 From the View menu, select Toolbar →Text Labels. 

To hide or display the Status Bar: 

 From the View menu, select Status Bar. 

Status Window Information 

 Click the Start button in the main tool bar; or Select Scanner → Start Scanner from the menu bar. The 
Scanner dialog box opens (Figure 3.8). 
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Figure 3.8 The Start Scanner dialog box 

 

2. Click Start in the Scanner dialog box. 

The Start window appears (Figure 3.9). 

Figure 3.9 Scanner dialog box 

 

If you want to skip the warm-up period before scanning the first probe array, keep the default check in the 
Arrays at room temperature box. 

3. Click OK in the GeneChip Scanner dialog box to start the run. 
 

 
NOTE: The scanner will enter Park mode if it is unattended for 15 minutes and will enter 
standby, or sleep, mode if it is unattended for 60 minutes (45 minutes after entering Park 
mode). The green light will turn off and the yellow light will turn on. To reactivate the 
laser, click Turn Laser On in the scanner dialog box and wait 10 minutes. Use appropriate 
settings based on the probe array type specified during experiment setup. 

 

 
NOTE: You cannot modify the scanner settings. GCC automatically selects the 
appropriate settings based on the probe array type specified during experiment setup. 
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4. Click OK in the GeneChip Scanner dialog box to start scanning the probe array. 
During the scan, the green light will flash, and the yellow light will be off. After the scan starts, the software 
will start with the autofocus routine. Data collection starts after successful completion of autofocus. During the 
pre-scan state, when autofocus is complete, but before data collection has started, the software will count 
downwards. 

After the scan is completed, GCC: 
 Saves the image data.  
 Aligns a grid on the image to identify the probe cells.  
 Computes the probe cell intensity data. 

Once the probe intensity data (.cel file) has been generated, probe summarization can be performed in 
Expression Console, or other applicable downstream software. 
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Appendix A Fluidics Station Care and Maintenance 
This appendix provides instructions on caring for and maintaining the instrument, including a weekly fluidics station 
bleach protocol, and guidelines for troubleshooting should problems arise. 

Instrument Care 
 Use a surge protector on the power line to the fluidics station.  

 Always run a Shutdown protocol when the instrument will be off or unused overnight or longer. This will 
prevent salt crystals from forming within the fluidics system. 

 When not using the instrument, leave the sample needles in the lowered position. Each needle should extend 
into an empty vial. This will protect them from accidental damage. 

 Always use deionized water to prevent contamination of the lines. Change buffers with freshly prepared buffer 
at each system startup. 

 The fluidics station should be positioned on a sturdy, level bench away from extremes in temperature and away 
from moving air. 

 
IMPORTANT: Before performing maintenance, turn off power to the station to avoid injury 
in case of a pump or electrical malfunction. 

Instrument Maintenance 
To ensure proper functioning of the fluidics station, you should perform periodic maintenance. 

Fluidics Station Bleach Protocol 
We recommend a weekly cleaning protocol for the fluidics station. This protocol uses commonly purchased sodium 
hypochlorite bleach. 

This protocol is designed to eliminate any residual SAPE-antibody complex that may be present in the fluidics station 
tubing and needles. The protocol runs a bleach solution through the system followed by a rinse cycle with deionized 
(DI) water. This protocol takes approximately one hour and forty minutes to complete. We recommend running this 
protocol weekly. You can find the current version of the protocol at our web site. 

The Bleach Cycle 
To avoid carryover, or cross contamination, from the bleach protocol, we recommend the use of dedicated bottles for 
bleach and DI water. You can obtain additional bottles from our company. 

Table A.1 Recommended Bottles 
Part Number Description 

400118 Media Bottle, SQ, 500 mL 

400119 Media Bottle, SQ, 1000 mL 
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1. Disengage the washblock for each module by pressing down on the cartridge lever. Remove any probe array 
cartridge (Figure A.1). 

Figure A.1 Disengaged washblocks showing cartridge levers in the down position, remove any cartridges 

 

2. Prepare 500 mL of 0.525% sodium hypochlorite solution using deionized water. For example: follow these 
directions to make 500 mL of bleach. 

In a 1 liter plastic or glass graduated cylinder combine 43.75 mL of commercial bleach (such as Clorox™ 
bleach, which is 6% sodium hypochlorite) with 456.25 mL of DI H2O, mix well. Pour the solution into a 500 
mL plastic bottle, and place the plastic bottle on fluidics station. 

 
IMPORTANT: The shelf life of this solution is 24 hours. After this period, you must prepare 
a fresh solution. 

3. Place on the fluidics station an empty one liter waste bottle, a 500 mL bottle of bleach and a one liter bottle of 
DI water as shown in Figure A.2. Insert the waste line into the waste bottle (Figure A.2). 

4. Immerse all three wash and water lines of the fluidics station into the 500 mL of bleach solution (Figure A.2). 
DO NOT IMMERSE THE WASTE LINE INTO THE BLEACH. 

 

 
NOTE: The BLEACH protocol requires approximately one liter of DI water. 

5. Open GeneChip Command Console software (GCC). Click the Microsoft™ Windows™ Start button and select 
Programs → Affymetrix → Command Console → GCC Fluidics Control. The GCC Fluidics Control 
window opens. 
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Figure A.2 GCC Fluidics Control window 

 

6. In the Protocol drop-down list box select the current bleach protocol (in the current example, it is 
BLEACHv3_450) for each of the respective modules. 

7. In the Station ID section, select all four modules, 1 to 4, and click the Run All button. The fluidics station will 
not start the bleach protocol until you press down on the needle lever (Figure A.3). 

 
NOTE: Temperature will ramp up to 50°C. 

8. Follow the prompts on each of the LCD. Load empty 1.5 mL vials onto each module if you have not already 
done so. 

9. Press down on each of the needle levers to start the bleach protocol (Figure A.3). 
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Figure A.3 Press down on the needle levers to start the bleach protocol. 

 

10. The fluidics station will begin the protocol and begin to empty the lines and perform the cleaning cycles using 
bleach solution. 

11. After approximately 30 minutes, the LCD will prompt you when the bleach cycle is over and the rinse cycle is 
about to begin. 

The Rinse Cycle 
Once the bleach cycle has finished, the second part of the protocol is a rinse step. This step is essential to remove all 
traces of bleach from the system. Failure to complete this step can result in damaged arrays. 

1. Follow the prompts on the LCD for each module. Lift up on the needle levers and remove the bleach vials. 
Load clean, empty vials onto each module. 

2. Remove the three wash and water lines from the bleach bottle and transfer them to the DI water bottle (Figure 
A.4). At this step, you need not be concerned regarding the bleach that remains in the lines. 
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Figure A.4 Immerse the three wash and water lines in the DI water bottle. 

 

3. Press down on the needle levers to begin the rinse cycle. The fluidics station will empty the lines and rinse the 
needles. 

4. When the rinse is completed after approximately one hour, the fluidics station will bring the temperature back 
to 25°C and drain the lines with air. The LCD display will read CLEANING DONE. 

5. Discard the vials employed for the bleach protocol. 

6. Follow these suggestions after you have completed the bleach protocol (Table A.2). 
Table A.2 Quick Reference Guide to Using the FS-450 

If you are: Then do this: 

Planning to use the system 
immediately 

After running the bleach protocol, remove the DI water supply used in the rinse 
phase and install the appropriate reagents for use in your next staining and washing 
protocol (including fresh DI water). 

 Perform a prime protocol without loading your probe arrays. 
Failure to run a prime protocol will result in irreparable damage to the 
loaded hybridized probe arrays. 

Not planning to use the 
system immediately 

Since the system is already well purged with water, you need not run an additional 
shutdown protocol. 
Just remove the old DI water bottle and replace it with a fresh bottle. 

Not planning to use the 
system for an extended 
period of time (longer than 
one week) 

Remove the DI water and perform a “dry” protocol shutdown. This will remove 
most of the water from the system and prevent unwanted microbial growth in the 
supply lines. 
Also, remove the pump tubing from the peristaltic pump rollers. 
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NOTE: After you have completed the bleach protocol, discard the used vials. 

Peristaltic Tubing Replacement 
Periodically the peristaltic tubing requires replacement because of wear, contamination, or in order to avoid salt 
buildup. Inspect the tubing, if you see evidence of these conditions, follow the procedure outlined below. 

 

 

IMPORTANT: For systems in routine use, we recommend monthly replacement of the 
tubing. To ensure proper performance, use only tubing available from the manufacturer. 
This tubing is manufactured to the required specifications to ensure proper fluid delivery 
and array performance. You can obtain additional tubing by ordering: 

 Tubing, Silicone Peristaltic, 8.5; P/N 400110. 

 

Wear gloves when changing tubing. Do not allow fluid from old tubing to spill onto surfaces. 

1. Open the module door (Figure A.5). 

Figure A.5 Module door open showing peristaltic tubing 

 

2. Open the white clamps to release tubing on both sides. See Figure A.6. 

 

IMPORTANT: Do not attempt to replace the tubing on a module where the module has 
been removed from the case of the fluidics station. In this case, rotating the pump may 
damage the motor driver circuitry. 
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Figure A.6 

 

3. Pull tubing off while gently turning the peristaltic pump head. Discard old tubing. 

4. Replace tubing with new peristaltic tubing supplied with the accessory kit as described below: 
a. Attach one end of the new tubing to the fitting on the right at the top of the pump enclosure. 
b. Insert the tubing into the clamp under the fitting without stretching the portion of the tubing between the 

fitting and the clamp. There should be a small amount of slack in that portion of the tubing. 
c. Work the tubing into the pump head while slowly turning the pump. 
d. Insert the free end of the tubing into the other clamp, and attach it to the other fitting. 
e. Close the drop-down module door. 

5. Order more replacement tubing (P/N 400110). 
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Troubleshooting and Assistance 
If problems arise with the fluidics station, use the following tables to locate the description that matches the problem. 
If you cannot find a solution, call Technical Support for assistance. 

Troubleshooting Decision Tree 
The following simple flow charts (Figure A.7 and Figure A.8) show you how to begin troubleshooting the FS450/250 
for a Missing Fluid Error (MFE). 

Figure A.7 
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Figure A.8 
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Problems and Solutions 
Table A.3 Common error messages, their meanings, probable causes and solutions 

Error Message Problem Possible Cause Solution 

Missing Fluid Error 
 

Cartridge not filling 
completely with sample 
solution or buffer during 
initial stages of 
hybridization wash or 
staining protocol 

Possible holes in the septa 
of the cartridge. 

Run Recover script, and 
then use another cartridge. 
 

Sample or staining solution 
not in place properly. 
 

Run Recover script. Make 
sure sample or stain vial is 
in the sample holder. 
 

Insufficient volume of 
sample or staining solution 
(<600 µL). 
 

Run Recover script. Add 
more sample solution to the 
sample vial. 
 

Blocked sampling tube or 
line of the fluidics station. 
 

Run Recover script. Run 
the Clean or Prime script 
with fresh deionized (DI) 
water to flush out salt 
blockage. 
 

Failure of one of the 
fluidics sensors. 
 

Call Technical Support for 
service. 
 

Pump tubing stretched too 
tightly around the pump. 

Loosen the tubing clamps, 
allow tubing to relax, close 
the clamps. 

Cartridge not filling 
completely with buffer 
during wash script 

Buffer bottle empty. 
 

Fill buffer bottles. 
 

Module not primed. Prime module. 
System detects improper 
conditions while filling. 
Note where in protocol 
error occurred. 

 Missing or insufficient 
stain or antibody in 
vial? 

 Wash empty? 

 Air bubbles in line? 

 Leaks? 

Identify if chip is filled 
 If important to recover 

fluid in chip, and then 
run Recovery script, 
followed by Resume 
function 

  If not important to 
recover fluid in chip, 
run Resume function 

Recovered less sample than 
initial input during Recover 
script. 

Loose tubing attachments 
inside the fluidics station. 

Call Technical Support for 
service. 
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Error Message Problem Possible Cause Solution 

Fluidics Station X  
Does Not Respond 

 Power not switched on at 
the fluidics station. 
 

Turn fluidics station power 
on, and then try to connect 
again. 
 

Incorrect fluidics station 
designated for 
communication. 
 

Designate correct fluidics 
station on workstation. 
 

Loose cables. Firmly connect cables to 
fluidics station. 

Sensor Timeout “Sensor Timeout” error 
message on workstation. 

No user response to 
“Remove Vial” prompt or 
other prompt. 

Start the selected script 
again. 

Error While Draining  
Error While Filling 

Cartridge is not filling or 
draining properly. 

Defective septa in 
cartridge. 
 

Use a new cartridge. 
 

Insufficient sample or stain 
volume. 
 

Add more sample solution 
to sample vial. 
 

Excessive bubbling in 
cartridge. 
 

Change the buffer: reduce 
detergent. 
 

Buffer conductivity too 
low. 
 

Change the buffer: increase 
salt. 
 

Failure of one of the fluid 
sensors. 

Call Technical Support for 
service. 

Error While Filling System detects improper 
conditions while filling. 
Note where in protocol 
error occurred. 

 Missing or insufficient 
stain or antibody in 
vial? 

 Wash or DI water 
empty? 

 Air bubbles in line? 

 Leaks? 

Identify if chip is filled: 
 If important to recover 

fluid in chip, and then 
run Recovery script, 
followed by Resume 
function 

 If not important to 
recover fluid in chip, 
run Resume function 
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Error Message Problem Possible Cause Solution 

Invalid Command Communications error 
detected 
 Note where in protocol 

error occurred 

 Identify if chip is filled. 
 If important to recover 

fluid in chip, and then 
run Recovery script. 

 Attempt to rerun script 
if sample loss can be 
tolerated. If problem 
persists, contact 
Technical Support for 
service 

 If sample loss cannot be 
tolerated, do not 
attempt to rerun script. 
Contact Technical 
Support for service 

Temperature  
Timeout 

Temperature does not 
reach specified 
temperature. 

Temperature has not 
reached required level in 
expected time if ambient 
temperature is within 
operating specifications 
(15-30°C). 

Call Technical Support for 
service. 

Improper Script Script does not work. User is attempting to run a 
FS400 script on FS450Dx 

Download proper 
FS450Dx script and 
continue 

Valve Motion Error   Run Home script and run 
desired script again If 
problem persists, contact 
Technical Support for 
service. 

Valve Not Homed   Run Home script and run 
desired script again If 
problem persists, contact 
Technical Support for 
service. 

Valve Out of Position   Run Home script and run 
desired script again If 
problem persists, contact 
Technical Support for 
service. 
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Meaning of Error Messages 
The following lists some of the common error messages and what they mean (Table A.4). 

Table A.4 Common Error Messages 

Error Message Meaning 

“Invalid Command” The script contains a command that cannot be executed because its command code 
is either undefined or has a format error. 

 
“Improper Script” The first command of the script is not the required FS450 command. 

“Temperature Timeout” The Re-attempt command timed out before the set point temperature was reached. 

 
“Sensor Timeout” The Await Sensors command timed out before the anticipated sensor pattern was 

seen. 
 
“Valve not Homed” The Home command did not result in the valve reaching its HOME position. 

“Valve Motion Error” The Valve command did not result in the valve reaching its target valve position. 

“Valve out of Position” According to the outer valve encoder, the valve did not reach a valid position when 
it was last rotated. 

 
“Error while Filling” While filling the cartridge, the AwaitMotor command terminated because of the 

step count not meeting/achieving the expected sensor pattern, and that the same 
error had occurred several times consecutively.  

 “Error while Draining” While draining the cartridge, the AwaitMotor command terminated because of the 
step count not meeting/achieving the expected sensor pattern, and that the same 
error had occurred several times consecutively.  

 
“Missing Fluid Error” 
Examples: 
“Stage C” “WashA” 
“Sense/Threshold” “960/890” 

“Stage C” “WashA”  
“Sense/Threshold” “960/890” 
The Pump command completed its step count before the conductivity sensor 
determined that the cartridge contained a solution with conductivity below the set 
threshold value. 
 
The Missing Fluid Error (MFE) Display not only gives a visual notification of an 
error condition to the operator, but gives the operator information that enables 
him/her to determine the cause of the error. It does this by displaying information 
about the sensor value and the fluid that caused the error. It shows this internal 
information in a continuous loop until the machine is powered down or a script is 
started. 
 
For example:  
Missing Fluid 
Error for 4 seconds 
Stage A 
valvePos WashA for 4 seconds  
Sense/Threshold 
820/600 for 4 seconds 
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Other Problems and Solutions 
Table A.5 lists other problems, causes and solutions that you may encounter. 

Table A.5 Other Problems 
 

Problem Possible Cause Solution 

Air bubbles left in cartridge at the 
end of a hybridization-wash script. 

Air bubble in wash line Manually fill cartridge with Buffer A 
or Array Holding Buffer. 

Buffer leaking inside the fluidics 
station. 

Loose tubing attachments inside 
the fluidics station. 

Call Technical Support for service. 

Washblock requires replacement. Call Technical Support for service. 

Salt buildup in the lines of the 
fluidics station. 

Run the Clean or Prime script with 
fresh DI water to flush out salt 
blockage. 

Cartridge needles of the fluidics 
station not engaging with the 
cartridge. 

Possible defective septa on the 
cartridge. 

Use another cartridge. 

Extra flashing on the cartridge. Use another cartridge, or call 
Technical Support for service. 

Salt buildup on the cartridge 
needles. 

Run the Clean script with fresh DI 
water to flush out salt blockage. Clean 
cartridge needles with a wet cotton 
swab. 

Cartridge holder aligned and 
attached to the fluidics station 
improperly. 

Call Technical Support for service. 

Cartridge holder not properly 
engaged to the fluidics station. 

Place the cartridge into the cartridge 
holder. Push the holder door shut, and 
firmly lift the lever to engage the 
cartridge needles. 

Sample needles do not properly 
enter vial. 

Bent sample needle Replace sample needle. 

User may be pressing the needle 
lever down to quickly or with too 
much force. 

Engage sample needle lever more 
slowly and/or with less force. 
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Documentation and support 

 
Obtaining support 
Technical support For the latest services and support information for all locations, visit 

www.thermofisher.com. 

At the website, you can: 

 Access worldwide telephone and fax numbers to contact Technical Support and Sales 
facilities 

 Search through frequently asked questions (FAQs) 

 Submit a question directly to Technical Support (thermofisher.com/support) 

 Search for user documents, SDSs, vector maps and sequences, application notes, 
formulations, handbooks, certificates of analysis, citations, and other product support 
documents 

 Obtain information about customer training 

 Download software updates and patches 

Safety Data 
Sheets (SDS) 

Safety Data Sheets (SDSs) are available at thermofisher.com/support.  

Limited product 
warranty 

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in 
the Life Technologies’ General Terms and Conditions of Sale found on Life 
Technologies’ website at www.thermofisher.com/us/en/home/global/terms-and-
conditions.html. If you have any questions, please contact Life Technologies at 
www.thermofisher.com/support. 

 

http://www.lifetechnologies.com/
http://www.thermofisher.com/support
http://www.thermofisher.com/support
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/us/en/home/global/terms-and-conditions.html
http://www.thermofisher.com/support
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